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About the Scholarship Payment Application Work Flow

Each academic department has a designated scholarship administrator, who uses
this work flow to request that a scholarship payment be made to a student account;
in the current, or in a future term. The request form passes to the person who is
responsible for authorizing payments from the scholarship account. Upon approval,
the Office of Student Financial Aid processes the transfer of funds.

Administrators may also use this form to revise or delete a payment.
They may look up a past request by querying the list of Historical Scholarship
Payment Authorizations.

Workflow General Reference is recommended reading to accompany this
document, see http://www.kent.edu/is/training/documentation.cfm to download.

Get Help With This Process

To obtain access to participate in this work flow, contact your departmental
security administrator, or Sheila Wilson at (330) 672-0528, swilso59@kent.edu for
assistance. If errors are discovered which require immediate action after a form has
been submitted, contact Sheila.

Note your authorizers here in case you need to request the return of a form:

1 Orignator scholarship administrator
2 Dean-Level Authorizer
3 Financial Aid Authorizer

Contact the Help Desk at 330-672-4357 for technical support (e.g. can’t see Worklist,
can’t log in, browser problems with the work flow.)

Contact any of the Office of Student Financial Aid Scholarship Coordination Services staff
below if you have questions about the this process or scholarships listed on the form:

Assistant Director Joyce Moore, Scholarship Coordination
Sandra Montgomery (330) 672-0501  Services Secretary
smontgl@kent.edu jmoore@kent.edu

Financial Aid Counselor, Scholarships
Sheila Wilson (330) 672-0528
swilso59@kent.edu



http://www.kent.edu/is/training/documentation.cfm�
mailto:smontg1@kent.edu�
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Part I. Initiate and Submit an SPA Form

Initiate a New Scholarship Payment Authorization

FWFS ¢My | 2 BT WG B M Campus +My Courses kLibrary »Student Career Path »Help »My Tab

My Banner

Banner INB
Authorized users, access Banner's
adminstrative services from the headline.

S]]

Finance Self-Service Banner
Authorized users, access Banner's finance
sel-service from the headline.

Please note: Ifyour user account has not
heen granted permission to access certain
areas of Banner INB, these links will not
work far you.

HOEXN

Leave Report {Current and Previous Pay
Periods)
Training Coardinatar,
00 - Applic Development &
Services, 100504
Semi-Monthly - 19, Due Date : Oct
14, 2007 (Mot Started)

Time Reporting

Training Coardinatar,

Welcome

3 are currentl

=2 9

e-mail calendar

October 8, 2007

Workflow & Utilities BEEE | My Worklist F@EE
Utilities Wioedlows Name Activity Created Details
* ERO01926: Reviaw 14 Sep-2007 09:29:14 Al L
FlashCart FLASH Amount-$88.32
Tap into CART
this
resource
for
purchasing Ferfarming
power.
¢ Reporting {Cognos) ¥ Fisfresh [F] Show Entire Waorklist [0 Open SCT wor kflow
Workflow

Helpful Hints Q==

Electranic PAF - Part-time Faculty
Employee Mame Change
Employee Marital Status Change
Employee Education Level Change
Expense Reimbursement

Fosition Request Autharization
Schalarship Payment Authorization

Access Information

Flease note: when accessing resources through the FlashLine, cerain
secUrity measures remain in place. These precautionary measures help
pratect critical Kent State University infarmation. Ifyou experience an error
when accessing certain resources, it could he due to where you are
physically located atthe time you tryto access resources. As a reference:

On & Off Campus Access

+ Flashline portal
* Banner Self-service

Step Action

1 Open a web browser and go to your campus homepage, or www.kent.edu

2 Locate the FlashLine login fields, type your FlashLine ID and password.

3 In Flashline, locate and click the My Action Items tab.
Look for the Workflow and Utilities channel.

4 Workflow items are listed alphabetically.
Click Scholarship Payment Authorization.

5 If you do not see the tab, channel, or link, contact the Help Desk at 672-4357.
Say, “I am missing the --- tab in FlashLine” (or channel, or link needed.)
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Open a New Authorization Form

Scholarship Payment Authorization

Begin a New Scholarship Payment Authorization: [
_OR -

Click here to search for Historical Scholarship Fayment Authorizations

Step Action

Click the checkbox “Begin a New Scholarship Payment Authorization” to
open a blank authorization form. Continue on the next page.

Search for an Authorization in Progress

Submission Date:

Workflow Specific name:  |SPAFDI0004 |

Workflow Start Date Range: | |==mTo| |=
{mmiddinasy)
Workflow End Date Range: | |=mTo| |=
(mmiddisasy)

[ Search ] [Clear] [Reset ]

<2 G0 Badkto Main Menu

Step

Action

Click the text link “Click here to search for Historical Scholarship Payment
Authorizations” to look up an authorization in progress.

2 When you submit an authorization, an email is sent confirming that the form is
in process, which provides the form Reference Number. (See p.8.)

3 Copy and paste, or type the Reference Number of the authorization in the
Workflow Specific Name field, as in the example above.
(Type %SPAF% to view all active forms, if you can’t remember the #.)

4 Click Search. Search results of one or more forms will appear on the screen.
Click a form title to open and view the form information.

Note | To correct a form that has been submitted, contact the form approver.

Request that they open the form and click Return for Rework.
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Identify the Aid Year and Scholarship Name

Scholarship Payment Authorization

Academic Year: [0812 v
Mead help?

The accounting information associated with this fund:

Scholarship: |Select Scholarship . . . v
Select Scholarship . ..
Stark Evening Student Sch (SPMB0S)

if vour scholarship {Stark Multicultural Sch (SPMEOB) e is incorect, please contact Stucient Financial Aid.
Stark Mon-Traditional Sch (SPMB07
" -

Flease enter Ban 5 for terms with two decimal

points. Totals will Amount
o TName action [summer 11 [rall 11 Jspring12__[rotal |
(I [ Ii Il |
2 I | I Il |
s ] | I Il |
« 1] | I Il |
s ] | I Il |
3 I | I Il |
) I | I Il |
e [ ] [ Ii Il |
s ] | I Il |
o[ ] | i Il |
InitialiRevised: Delete: Transaction:

Additional Comments (250 Character Maximum): Route For Dean's Approval?

MOTE: Please do not wse the following legal characters: (™ %, ~, ' --)

Step Action

1 Select the Aid Year (the school year in which aid is authorized) by pulling down the
Academic Year menu of choices.

The year code is TTYY, and you will see TT 08 = Fall.
For example, 0811 is Fall 2011 or academic year 2011-2012.

The accounting information for the fund will appear to the left of the fund name. (You
should only see the names of awards which you are personally authorized to process.
Contact Financial Aid if there are errors in this list.)

STOP | Confirm that the accounting information associated with the fund is correct.

CHECK | information will cause the wrong account to be billed.

Note | One scholarship fund, and up to ten awards are accomodated per form.

2 Select the name of the scholarship to be awarded from the pull-down Scholarship menu.

& If you see an error, do not process the form. Contact Financial Aid immediately. Incorrect
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Enter Award Recipient ID(s) and Award Amount(s)

Flease enter Banner |Ds below. Select an action and enter amounts for terms with twa decimal
points. Totals will calculate automatically:

1. 800016051 | Mayfield, Trudy

Step Action
1 Type the Banner ID of an award recipient in the first ID field.
2 Press Tab. The recipient name should appear in the Name field.
3 Leave the Action column selection set to “Initial”.

Summer 11_[Fall 11 [Spring12__[Total |

Amount

2002.00 2001.00 $4.003.00

Step

Action

There are three term periods within a school year. Type the dollar amount of
an award into the first appropriate term field.

Note

It is not necessary to type a decimal place and cents figure, as award amounts
are in whole dollars. Never type a comma in a dollar amount.

Press Tab. The amount you typed will appear in the Total field.

If applicable, click in another term field and type an award amount.

Press Tab. The Total amount will update.

[N NE N REE]

To change a figure, click twice in a field to highlight the dollar amount, and
type over a new dollar amount. Press Tab to update the Total field.

To enter additional recipients for the same scholarship, go back to step 1.
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Modify a Previously Awarded Amount or Delete an Award

This option is for changes after the initial SPAF has been submitted and processed by
Student Financial Aid. If the form has not yet been processed by Financial Aid, contact
your form authorizer, and ask them to open the form and click the Return for Rework

option.

Please enter Banner IDs helow. Select an action and enter amounts for terms with two decimal
points, Totals will calculate automatically:

1. |BO0016051 Mayfield, Trudy Change
Step Action
1 Enter the Banner ID of the individual whose award is to be revised or deleted.
2 Press Tab. The name will appear in the Name field.
Note | For revisions and deletions, indicate the amount to be reflected on the
student’s award letter, not the amount of the reduction or increase.
For example, if the initial award was for $500 and should be deleted, select
Delete in the action column and enter “$0.00” in the appropriate award
amount field.
3 From the Action field, pull down the menu and select Revised to modify an

existing award; or Delete to cancel an award.

Summer 11_[Fail 11 [Spring 12

Amount

2001.00 2002.00 $4,003.00
Step Action
4 If the award amount is to be revised, type the new award figure for the first
term, and press Tab to update the Total field.
5 If applicable, revise the amounts in the other term fields, pressing Tab to
update the Total field each time.
6 To delete an award, click twice in a field to highlight, and press Delete.

Press Tab to update the Total field.




Scho

larship Payment Application Form p.9of 13 April 21, 2011

Submit the Authorization Request

Transaction: |$4,003.00

Route For

Approver: Mark Sherrod

Dean's Approval? | Yes ¥

Step Action
1 Some departments and scholarships route approvals through the college Dean.
If this option is available, you will see the question above.
According to your department policy for the scholarship,
select Yes to route authorization to the Dean, or No to bypass the Dean.
Note | Double-check the entries, because once the form has been submitted, you
must call the approver to get it back in order to make corrections.
2 You may enter a comment in the Additional Comments field, if desired.
3 Click Submit to send the request to the next person in your approver chain.
4 When you Submit the request, the message below will appear, and an e-mail is
sent to you which contains the ID number of the request.

You have successfully submitted this Scholarship Payment Authorization.

A copy of this document can be refrieved from the historical docurments visw. The hisforical
view can be accessed from the “Warkfiow & Uliiies” channe! on the "My Action ftems"tab in

Meed help?

Flashling.

Scholarship Payment Authorization SPAFODD006 for Dr K R Wulff Scholarship-A¥R0811 has been submitted
WWORKFLOW
To: ALFORD, ELYCIA §

Cc:

Kent State University Workflow Notification

The Scho

larship Payment Authorization SFPAFO00006 for Dr K R M\ulff Scholarship has been submitted.

Flease save the reference number for future inquiries about this Schalarship Payment Authorization

Reference Number: SPAF000006 ﬂ
Creator, Elycia Alford
Scholarship: Dr K Rl Scholarship-AYR 0811

Workflow Start: 31-Mar-2011
Total Armount: 4003

Last Acti

on: Submitted For Approval
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Correct a SPA Form After Submission

Welcome to | Welcome =

FlashLine 7

FWFS ¢My HR BECR Tl WG B> My Campus *My Courses kLibrary »Student Career Path »Help »My Tab

My Banner @OEE | | Workflow & Utilities @EE | My Weorklist FOEE

Banner INB Utilities Woddlow Hame Activity Created Details

Authorized users, access Banner's g )

adminstrative senices from the headling * SPAFO00004: Wind Review 28-Mar-z011 02:44 4
FlashCart FLASH Scholarship-AYR

Finance Self-Service Banner Tapinta CART 0811

Authorized users, access Banner's finance this Ready

selt-service from the headline. resource
for

Please note: fyour user account has not purchasing Ferfarming

heen granted permission to access certain power,

areas of Banner INB, these links will not "

work for you. ¢ Reporting {Cognos) [¥] Refrash [F] Show Ertire Warklist 8] Open SCT Workflow

Step Action

1 To change/correct a form that has already been submitted,

contact the next person in the approval chain.

Ask this person to open the form and click the Return for Rework button.

2 The form will appear in your Worklist in FlashLine, found on the My Action
Items tab (above). Click Open SCT Workflow to display the worklist (below.)

It is easier to scroll and find forms in the full screen Worklist view.

3 Click the form name (under the Workflow column) to open the form and make
corrections and comments as necessary.

Submit the form in the usual manner. It will return to the approver.

LLITE :o Worklist

wWorkflow Auckivity Priatity Created
SPAFOOO0DO4: Wind Approval Maorrmal 22-Mar-Z011 02:44:27 PM

User Profile E&sfmhle Scholarship-AYR

Shortouts Ready

A

SPAFOOODOZ: Wind Approval Haormal Z7-Mar-2011 05:05:19 PM
Ensemble Scholarship-AYR
0811

Ready
SPAFOOODO2: Wind Approval Marmal 27-Mar-2011 05:05:15 PM

Y
Ensemble Scholarship-AYR
0811

Feady

k]

Show Reserved Items
1-30f3 First ¢ Previous Mext o» Last Go to page:




Scholarship Payment Application Form p.11of 13 April 21, 2011

Part 2. Approve an SPA Request

Access the Worklist
Step Action
1 Approvers receive e-mail notification, as in the example below.
2 Log in to FlashLine and click the My Action Items tab.
3 Locate the My Worklist channel and click Open SCT Workflow.

Scholarship Payment Authorization SPAFO0D004 for Wind Ensemble Scholarship-AYR 0811 has been routed. ..
WDR L O

To: SHERFOD, MARK L

Cc:

Kent State University Workflow Nofification

The Scholarship Payment Autharization SFAFO00004 for'Aind Ensemhble Scholarship has been routed to wou far
approval.

Flease sawe the reference number for future inguiries about this Scholarship Payment Authorization.

Reference Number: SPAF000004

Creator: Elycia Alford

Scholarship: 'Wind Ensemble Scholarship-AYR 0311
Workflow Star: 28-Mar-2011

Total Amount: 100

Last Action: Submitted For Approval

Welcome tg | welcome 7 =
F IaShLi ne 5z L E‘-rna\l calendar
FWFS My HR BRI T WGl Bl - My Campus =My Courses kLibrary »Student Career Path »#Help »My Tah
My Banner Q= Workflow & Utilities @EE | My Worklist (B2 1=1[ES |
Banner INB Utilities Mo teflows Name Activity Created Details
Authorized users, access Banner's - )
adrminstrative services from the headling. * SP#FIIJIIIIJhII_IIM. Wind Review 28-Mar-z011 02:44 4
FlashCart FLASH Scholarship-AYR
Finance Self-Service Banner Tap into CART 0811
Authorized users, access Banner's finance this Ready
self-service from the headline. resource
for
Please note: If your user account has not purchasing Ferforming

heen granted permission to access certain power,

areas of Banner INB, these links will not - :
wark far you. Reporting (Cognos) | Refresh [F Showe Entire Worklist  [H Open SCT Workflow
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Open a Request Form

Home o0 Worklist

warkflow Activity Priority Created

SPAFO00004: Wind Appraoval Mormal 28-Mar-2011 02:44:127 PM ..\
Ensemble Scholarship-AYR
o811

Rezady
SPAFO00003: Wind Appraowval Mormal 27-Mar-z011 05:05:19 PM

Ensemble Scholarship-&YR
0811

Ready
SPAFO000D2: Wind Approval Mormal 27-Mar-2011 05:05:15 PM i

Ensemble Scholarship-AYR
0811

Ready

User Profile

X

Show Reserved Items

1-3of 3 First < Previous Next 5» Last| Goto page:_[1 v

Step Action

1 Forms waiting for approval will display Approval in the Activity column.

2 Click the form title in the Workflow column to open and review a form.
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Add Comments, Approve or Return

Marme: El'_'." cla 3. Alford Submission Date: 3/31/2011

Qrganization: Applic Development & S

Scholarship Payment Authorization

Heed hela?

Reference Number: SPAFO00004
Schﬂlarship: S|0M05 _ Wlnd Ensemb|e Scho|ar5hip The scocounding informafion 3ssociafed witlh fhis fmo:

Academic Year: 0511 indox__lndex Tl Porcontof Charges ___
220105 Wind Ens Sym Bd 100
I your scholarahin I not listed or the corresponding index fo be charged is Incarrect, please contact Student Financial id.
Amount
| o fName  |Action _ |Summer11]Fall11 Spring 12
1. 1801116052 [Siehest, Stephan Initial 100.00 $100.00
2.
3.
4.
o
G.
7.
3.
9.
10
InitialRevised: $100.00 Delete: $0.00 Transaction: |$100.00
Enter Additional Comments (250 Character Maximum):
HOTE: Piease do not use the following itiegal characters: (% % ~ - =) Select a routing decision:
I Approve ] [ Return For Rewark ]
Previous Comments:
Date  lUser ____ [Comment
35285201 Elycia § Alford These are my comments

Previous History:

Date  lUser _l[Status |

3/28/2011 Elycia 5 Aford  Submitted

Step Action

1 e Check amounts and terms for accuracy.
e [f the Action field indicates Revise or Delete, the payment amounts
have been altered. Totals are automatically calculated.

Type a comment if you wish.

Choose Approve or Return for Rework.

Select another form in the workflow list, or Exit by closing the worklist.

b |wWN

If you do not wish to advance the form at this time, Exit without a decision.
You may return to the Worklist later to select a decision.
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